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Revit to STL 
Convert Revit models into physical models. 
 

y following the instructions outlined in this manual, you will be able to create 
an STL file from Revit by exporting the file to a Nurbs editor such as Rhino. 
Creating a proper STL will allow your design to be built on a RedEye ARC 3D 
printer. If you are already modeling in Rhino, refer to this manual to help you 

check and correct the files integrity for 3D printing. 

STL Overview 
CAD-TO-STL 

The .STL file format has become the Rapid Prototyping industry's defacto 
standard data transmission format. This format approximates the surfaces of a 
solid model with triangles. For a simple model such as the box shown in figure 1, 
its surfaces can be approximated with twelve triangles, two on each side, as shown 
in figure 2. The more complex the surface, the more triangles produced as shown 
in figure 3. 

 

Almost all of today's CAD systems are capable of producing an STL file. For the 
user the process is often as simple as selecting File, Save As, and STL. 
In Revit® there is as yet no way to export the model directly as an stl file. So in order to 
to produce a clean stl file that we are able to print, we need to “finish” the file in a 
Nurbs editor such as Rhinoceros® or 3Ds Max ®. 
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Revit Export 
In this model made up in Revit®, we have only done some quick basic walls, windows, 
stairs, doors and some wall finishing for the purposes of demonstration only. 

 

 

 

 

 

 

 

 

 

Next we will need to export the file in a .dwg file format as follows. Under the File 
menu, select Export, Cad Formats. An export dialog opens. Navigate to the folder you 
are working from, select AutoCad 2000® dwg as your file format, name your file and 
click on the Options Button. In the Options dialog under Solids (3D views only): select 
Export as ACIS solids, click on the OK Button and save your file. 
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Rhinoceros® Import 
We are now ready to import our file into Rhinoceros® for “finishing” and exporting 
into a single solid stl file. From Rhinoceros® under the File menu, we select Import. In 
the Import dialog, under Files of type, select AutoCAD drawing file (*.dwg), select the 
file you exported from Revit® and click the Open Button. 

 

 

 

 

 

 

The first thing we want to do is getting rid of any empty layer or blocks that came with 
the file. Under the Tools menu, scroll down to the File Utilities fly out and select Purge 
Unused Blocks and Layers. Press enter to accept the default. Left click on the Layers 
Button to display the Layers. 

 

 

 

 

 

As you see Revit® has kindly named the layer so that we can understand what they 
contain. We will hide all the layers except 3D-WALL and make 3D-WALL active. We 
will change the color at the same time. Click on the colored square and select a color 
that is easier to work with. We will use Turquoise. To zoom our model right click on 
the Zoom Extents All Views button.  
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Then left click on the word Perspective in the Perspective view port to expand it to full 
screen. 

 

 

 

 

 
To orbit around our model, we just click and drag with our right mouse button, to pan 
hold down the shift key while we click and drag with our right mouse button. To zoom 
in or out, we roll our middle mouse wheel forward to zoom in and backward to zoom 
out. 

Should you find that you are having trouble zooming into your scene. Just draw a small 
line close to the area that you want to zoom into, select it and click on the Zoom 
Selected button. 

 

This will refresh your zoom ability and make it easier to zoom into your scene. All the 
walls created in Revit® are separate walls. We need to combine them into one single 
object. But first there are a few errors that need to be corrected. You will notice that all 
the door cutouts have a single surface across the bottom of the door cutout. These 
need to be removed before we start joining the wall together. 
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We can either select all the walls with door cutouts, or one at a time. It is easier doing 
them one at a time. After we have selected one segment, we click and hold the Hide 
Objects button until the Visibility fly out appears and the select on the Invert Selection 
and Hide Objects button. 

 

 
 

Click on the wall and left click on the Zoom Selected button. This will center the view 
port on the selected object and allow us to orbit around the selected object. With the 
wall still selected, we left click on the Explode button. 

 
 

Select the surface at the bottom of the wall cutout and delete it. Click and drag from 
right to left across the remaining surfaces to select them all, or use the shortcut key 
Ctrl-A and click on the Join button to rejoin them into one closed object. 

 

 

 
If the message surfaces or polysurfaces joined into one closed polysurface. Creating 
meshes... Press Esc to cancel appears, we have successfully created a solid object and 
we can continue to the next wall. Right click on the Show Objects button, left click on 
the Zoom Extents button, select the next wall and we repeat the process again until all 
the walls with door cutouts have all been corrected. 
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It is now time to start joining all the connecting walls together. For this we will use the 
Boolean Union function. We find that doing this in the Top viewport is easier. Click 
on the word Perspective in the viewport to bring up the four viewports and click on 
the word Top in the Top viewport to expand the Top viewport. Select two or three 
connecting wall segments and click on the Boolean Union button, repeating this 
process until all the connecting wall segments are one object. Once we have used the 
Boolean function and we are ready to repeat the process, we need only right click 
anywhere in the viewport to repeat the Boolean function. Right clicking will always 
repeat the last command used. 

 

 

 
The reason we suggest two or three segments at a time is that if an error occurs you 
will know were to start looking. Now that the entire connecting wall segments have 
been joined, we are going to use a command called Merge all Coplanar Faces. We 
could go look for the tool button, but we don't need to. 

We simply start typing the word merge and a list of all commands that start with the 
word merge will appear, we just click on the command that we want and select the 
object that we want to apply the command to. We do not have to click in any specific 
place to enter a command, we just start typing. 

Once we have selected the object that we want to apply the command to, simply right 
clicking will have the same effect as the enter key. Right clicking again will repeat the 
command. We continue until all the objects have been merged. We now have clean 
walls that are ready to be joined to the floor. 

Merge all Coplanar Faces, does exactly that. When two objects are joined together, the 
final object will still retain separate faces even if the surfaces are on the same plane and 
they are technically one surface. 

As shown in this example. (Left) two separate objects. (Middle) two objects with the 
Boolean union applied. (Right) all coplanar surfaces joined. 



 

 
7 

© 2008 RedEye ARC. All Rights Reserved. 

Next we will add our floor. In the Layers panel, we make 3D-FLOR-OTLN visible. 
Click on the Boolean Union button, select the walls, then the floor and right click to 
execute the command. We use the Merge all Coplanar Faces command again to merge 
all the coplanar faces. Finlay we will check to see that we have no naked edges by 
typing in the word show. A drop down list of commands will appear, select the 
ShowEdges command, select the walls/floor object and right click to execute. 

A message will appear that should read ' Found #### edges total; no naked edges.’ If the message 
reports 'no naked edges', you have a clean model and you can close the Edge Analysis 
panel. 

 

 

 

 

 

 

 

 

You are done with the walls and floor. They are now one single solid object and we 
can move on to our stairs. Make 3D-FLOR-STRS layer active and hide all the other 
layers. Change the color in the Layers panel to make it easier on the eyes. 

The stair is a block instance and we need to use the Explode command twice to break 
it down to separate surfaces. At the bottom of the stair, we may find a single surface 
that needs to be removed. 
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Delete the surface, select all the remaining surfaces and use the Join button to join 
them. We have about 40 polysurfaces. The stairs exported from Revit® have always 
been a problem. They are very thin and the chances are that they will cause boolean 
errors. We can spend hours trying to figure out why some of the stair segments will 
boolean properly and other segments just won't. So to save time and frustration, we will 
do a work around that will both give us thicker stairs and allow us to boolean without 
errors. The sides of the stair are not needed as the stair extends into the walls. We will 
not delete them but lock them so that we can use them for reference. Select the sides 
and click on the Lock Objects button. 

 

 

Create a new layer called Stair, make the new Stair layer active. 

 

 

 
 

Click on the Polyline button and turn the End snap on. 

 

Click and hold down the Shaded Viewport button until the Shade panel appears. Click 
on the Ghosted Viewport button. 
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We trace the stairs as shown, snapping to the end points. 

 

 

 

 

 

 

 

 

 

 

Turn on Mid snap. Type in extrude and select the ExtrudeCrv command. And extrude 
the curve to the middle of the inside side wall. 
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Type in the command MoveFace, select the outside face, right click to accept the 
selection. 

 

 

 

 
 

Click on the end corner point and drag the face to the middle of the outer side wall. 

 

 
 

Repeat the process on the upper part of the stair. 
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Once your upper part of the stair is done, we hide the 3D-FLOR-STRS layer. Click on 
the Boolean Union button, select the top and bottom segments of the stair and right 
click to complete the command. Type in the word merge and select Merge all 
Coplanar Faces command, select the stair object and right click to execute the 
command. Make the 3D-WALL layer active, click on the Boolean Union button, 
select the walls object, select the stair object and right click to execute the command. 
Again we use the Merge all Coplanar Faces command, select the walls object and right 
click to execute the command. 

So far our model is clean and error free and we can start on the doors. Make the 3D-
DOOR layer active and hide all other layers. Even though 3D-DOOR-FRAM and 3D-
DOOR-GLAZ are linked to the 3D-DOOR layer, we can ignore them for now. We 
will tackle the most complicated door first. The main entrance door. Select the door 
and click on the Invert Selection and Hide Objects button that we used on page 4. 

We select the door and click on the Explode button that we used on page 5. At first 
glance the door looks very complicated, but like all jobs that  look impossible, they are 
much easier when broken down into smaller components. 

As we will be hiding some of the components that make up this door, we will move 
this door to it's own layer. We select all the components Ctrl-A, click and hold down 
the Layers button until the Layer panel appears, select the Change Object Layer button, 
click New and type in the new layer name. We will call it FrontDoor. 
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Make the new FrontDoor layer active and hide all other layers. Select the front door 
main panel, Use the Invert Selection and Hide Objects button that we used on page 4. 
Select the door panel and click on the Explode button again. This time all we want to 
select are the panels that would make up the door without any trimmings. Select the 
front back and side panels. 

 

 

 

 

 

 

 

 

We will join this into one object and close up the holes, by Ctrl-A to select all and 
clicking on the join button. Using the Surface from 3 or 4 Corner Points button, we 
close the holes clicking on each corner in a anticlockwise direction (to insure the surface 
normal is facing outward). 
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Once we have inserted all the new surfaces, we join the all the surfaces together and use 
the Merge all Coplanar Faces command and our main door panel is ready for 
trimmings. Right click on the Show Objects button.  Select the top two panels by 
dragging from right to left to include everything related to the top panels and use the 
Invert Selection and Hide Objects button to hide everything else. 

 

 

 

 

 

 

 

The top panels are made up of surfaces and polysurfaces. All we want to work on are 
the surfaces. We will just type in the word selsrf to access the SelSrf command and 
press enter; this will select the surfaces only and not the polysurfaces. 

Use the Invert Selection and Hide Objects button and we are left with just the surfaces 
we want to work on. Select them all and click on the Join button to join them together 
to form two closed polysurface objects. We will use them later, but for now we are 
done with them and we can hide them with the rest. 

When we have a number of hidden objects, there is another handy tool that we can 
use to show only the objects that we want. This tool is the Show Selected Objects 
button, which will show all the hidden objects and ask you to select the objects that 
you wish to show. 

 

 

 

Selected the top panel polysurfaces. Even though they are polysurfaces, meaning that 
they are surfaces that are already joined together, they will often not work when we try 
to use a Boolean function on them. So we will need to rebuild them. You may think 
this will take a long time, but in reality its simple process. All we need to do is click on 
one object, Explode it and Join it again, that's it, done. Repeat the the steps on all four 
polysurfaces. Hide all four polysurfaces and use the Show Selected Objects to select 
the door handles.  



 

 
14 

© 2008 RedEye ARC. All Rights Reserved. 

Using the Show Selected Objects command again we will select the two bottom 
panels, by dragging from left to right across only the two bottom panels, we must be 
sure to enclose only the two panels, as only what is inside the rubber band will be 
selected. In this case we have only got surfaces to work with and no polysurfaces. We 
don't want the the four middle surfaces, so we can select them and hide them. 

 

The surfaces that we are left with will make up the objects that we will use later to cut 
into the door panel. Select them all and join them into four closed polysurfaces. We 
are now ready to complete our door. 
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We will first Boolean Union the door panel and the door handles. We type in the 
command Boolean and select the Boolean2Objects command and click on the door 
panel and either the inside or outside door handle and right click to accept. 

We will repeat the Boolean2Objects command on the four top outer panels. The 
inside top panels we will use to cut holes in our doors. To do this we will type in 
boolean and select the BooleanDifference command, select the door panel first, right 
click to accept and then the two inside panels and right click to process the command. 

 

 

Right click to repeat the command, select the door panel, right click to accept, select 
the four bottom panels and right click to process the command. 
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The door step and the door do not touch each other and will not boolean together. 
Orbit the viewport so that we are looking at the bottom of the door. We need to be 
able to see the bottom surface of the door.  Type in the word move and select the 
command MoveFace, select the bottom surface of the door, right click to accept, click 
on the the corner end point and drag the surface down enough to intersect the door 
step. 

 

 

Lastly we will use the Merge all coplanar faces to clean up the door object. 

All that’s left to do for the front door is to add the door frame. Make the 3D-DOOR-
FRAM layer visible, select the door frame, Explode, Join, Boolean2Objects, select the 
door first, select the door frame and right click to accept. Type in the command show, 
select the command ShowEdges, select the door object and right click to accept. We 
should have a message that says 'Found #### edges total; no naked edges.’ The main entrance 
door is ready to be added to the walls object. Make the 3D-WALL layer active, use the 
Boolean2Objects command, select the wall object, select the door object and right 
click to accept. Close the Show Edges panel. For the remaining doors we will remove 
the doors and only use the door frames to add to our walls object. 
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Make the 3D-DOOR-FRAM layer active and make the 3D-DOOR layer viable. The 
3D-DOOR-FRAM layer is linked to the 3D-DOOR layer, so they both have to be 
visible in order to see the door frames. Let's start with the glass sliding door frame. 
Select the door frame, Explode get out of  block mode. Select the door frame, 
Explode and Join the frame again. Select one of the sliding door frame, Explode and 
Join the frame. Repeat the process for the other sliding door frame. Use the 
Boolean2Objects command to join the three objects together, obviously two at a time. 

 

The remaining door frames are all still blocks. Select one at a time, Explode to remove 
the block mode, select each of the door frames individually, Explode and Join it and 
move on to the next door until all the doors are done. 

 

 

 

 

 

 

If it helps to delete the door panels, then delete them. 
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Make the 3D-WALL layer active and Boolean2Objects all the door frames to the wall 
object. It is important to remember to always select the wall object first. Whatever is 
selected first the second selection will be added to it. This means that the main model 
will always remain on the same layer. 

The windows, similar to the doors, are block entities that we need to Explode in order 
to be able to edit them. Not all the windows are the same type or size. First we will 
lock all the duplicate windows of each type and size. We only need to work on one 
and copy it to the other locations. 

 

 

Select the window on the front of the house. In order to be able to move this window 
to a new layer, we need to use the Explode function to get out of the block mode. 
Select the Change Object Layer button, create a new layer and call it WinodwFront. 
We need to break the window down into manageable parts. 

Select all the outer frames and hide them one by one, until we are left with only the 
parts that have glass in them. 
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Once we are down to the inside frame with glass, we can start to remove the glass. 

 

 

There is a separate glass pane that we can delete, but the other glass is contained in the 
remaining frame. 
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Delete the free standing glass panel and Explode the inner frame. There will be two 
surfaces that make up the glass that we can delete. 

 

 

We are now left with only the surfaces that make up the frame. Select all the surfaces 
and Join them together. 
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Select the polysurface the makes up the frame and hide it. Delete the remaining 
geometry. Select the Show All button, select the polysurface we just worked on and 
examine it overall place in the window. By examining it we can see that there is detail 
on the inside of the window that will be hidden. 

The polysurface that we worked on has bad geometry that is causing naked edges and 
will take hours to fix. So we will duplicate this frame with no hidden geometry. 

 

 

Invert Selected and Hide Objects. Select the frame, explode it, and select the front 
surface. 
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Hold down the Select All button until the Select panel appears. Select the Invert 
Selection button and lock the rest of the surfaces. Change to the Right viewport. 

 

 

We want to expand the surface to include the inside geometry.  
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For this we will use a command called MoveEdge, type it in, select the bottom inside 
edge, make sure Ortho is on,  right click to accept the edge, select the end point and 
drag the edge up until it aligns with the inside geometry making sure that you stay in line 
with the original vertical edge. 

 

 

 

Repeat these steps for the three edges remaining. Return to Perspective view. 
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Select the surface and Extrudesrf the surface to the inside of the frame. 

 

 

We can now use the Boolean2Objects command to join all the frames that make up 
our window and Merge all Planar Faces to clean it up. 

 

 

 

 

 

 

 

 

 



 

 
25 

© 2008 RedEye ARC. All Rights Reserved. 

Repeat the process for the remaining windows and Boolean2Objects the windows and 
walls together. 

The last piece of the puzzle to be added in this demo is the profile on the top of the 
walls. Make the 3D-FLOR-CASE layer visible. Select the extruded profile, Explode to 
get out of block mode, select one extruded profile at a time, Explode and Join them 
into single closed polysurfaces. Finish off by doing a Boolean2Objects and finally 
Merge all Coplanar Faces. Do one last ShowEdges command to be sure the model is 
clean and error free. A message reading 'Found #### edges total; no naked edges.' should 
appear. Select the model and under the File menu select Export Selected. Export the 
model as a stl file. A dialog appears, allowing us to adjust the size of the mesh. The 
mesh size should be a bit smaller than what the printer can print. 

 

We will change the value to 0.01 inches and select Detailed Controls. 
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Under Maximum angle we will change the angle to 35.0, check Refine mesh and 
Simple planes. 

After the mesh is calculated we are given the option to save the STL file as a binary or 
a ASCII file. Binary files are smaller. 

 

 

Our model is clean and error free! The 3 bad edges reported are so small that we can 
consider this model error free. Try to keep the bad edges reported under 10 and you 
should have no problem building your file. 

We hope you found this information useful, if you have any questions please feel free 
to contact your RedEye ARC Representative. 

 

Ryan Sybrant – Architectural Development Manager 

Email: Ryan.Sybrant@RedEyeARC.com 

Phone: 952-294-1574 

 

 




